
2 Financial Modelling in Practice

Figure 1.1

Example: SUBTOTAL

The SUBTOTAL function ignores other SUBTOTAL functions, and so avoids double-
counting when applied to a range that contains this function (unlike the SUM function,
which would lead either to double-counting or to a large set of cumbersome, inflexible and
error-prone formulae).

The function has an argument that allows different calculations to be performed on the
data set. For example, the sum of the range requires the use of the argument 9, whereas the
average and count require the value of 1 and 2 respectively (see the Help menu for the full
description).

Frequent uses of the function include:

• The creation of subtotals in a large list of data that is sorted into categories.
• In financial statement modelling, where a company’s total assets may be calculated from

the (subtotal) of its fixed and current assets, which may themselves each be calculated as
the subtotal of a more detailed breakdown (such as equipment, working capital, etc.).

• The analysis of sets of filtered data (see later), where the function ignores any hidden
rows that result from a list having been filtered (unlike SUM, COUNT).

The SUBTOTAL function can be entered either by direct insertion into a cell (by explicit
typing or insertion from the Math & Trig category), or by use of Data/Subtotal (Data/
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Figure 1.4

Example: AND

The file Ch1.Core.xlsx (AND worksheet) (Figure 1.4) shows the hypothesised development
of the gross domestic product (GDP) of the US and Chinese economies (indexed so that the
starting value of the US is 100), and demonstrates the use of AND to check whether two
conditions hold simultaneously. Various possibilities are shown, including a compound IF
statement, the AND function embedded within the IF statement, and the AND statement
applied to the result of checking individually whether each of the conditions is met. Note
that in the previous example, the AND function returns either TRUE or FALSE.

Example: SUMIF

The SUMIF function adds the values of the cells in a range according to whether a criterion
is met in another range.

The file Ch1.Core.xlsx (SUMIF1 worksheet) (Figure 1.5) shows its use to calculate the
total capital expenditure from Year 7 onwards in a 10-year forecast, as well as to lookup
the capital expenditure in Year 9 (this could also be achieved with a Lookup function,
described later).

The SUMIF function can be particularly useful in modelling applications where the values
of some model inputs are themselves derived from data sets.
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Figure 1.16

back from the labels area of the Field List window. A PivotTable can be deleted using
the PivotTable Tools by choosing Select/Entire PivotTable and then clearing the contents.
PivotCharts can also be produced and are essentially self-explanatory once one is familiar
with PivotTables.

The file Ch1.Data.xlsx (PivotTable worksheet) (Figure 1.17) shows an example.

STATISTICAL FUNCTIONS

Statistical functions are often required to conduct analysis of historic data (for example, to
calibrate model inputs) and to analyse the results of models (such as simulation models,
where the output is typically a large data set). Basic arithmetic operations can be conducted
with functions such as AVERAGE, COUNT, MIN and MAX described earlier.

Certain statistical functions relate to the variability found in data sets, such as:

• CORREL calculates the correlation coefficient between two data sets.
• COVAR calculates the covariance of two data sets (the extent to which the data sets

co-vary, such as large values in one set occurring generally when large values in the
other occur).

• SLOPE calculates the slope of the linear regression line of two data sets.
• STDEV calculates the standard deviation of a population based on a sample. Similarly,

VAR calculates the variance (i.e. the square of the standard deviation). STDEVP and
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VARP calculate the same figures assuming that the data provided is the whole population
rather than a sample, hence requiring no correction for biases introduced by samples.

Functions that provide further statistical measures about a data set include:

• KURT calculates the coefficient of excess kurtosis (i.e. the figure is adjusted by subtract-
ing 3, so that a Normal distribution would have a KURT of zero). The meaning of this
is discussed in Chapter 4.

• SKEW calculates the coefficient of skewness; its meaning is also discussed in Chapter 4.

Functions that provide measures of the order of points within the data set include:

• LARGE and SMALL show the value of a point with a certain rank in the data set (e.g.
the kth largest or smallest value).

• RANK calculates the rank (i.e. ordered position) of a data point within its data set.

When implementing simulation techniques (see Chapter 6), other frequently required
functions include:

• NORMSINV calculates the inverse cumulative Normal distribution, i.e. requires a prob-
ability as an input and calculates the value from a standard Normal distribution that
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Figure 1.19

(when ordered in ascending order). The CORREL function is applied to both sets of data.
There is a slight difference in the correlation coefficients calculated by the two methods.
(Note that Excel also has a function PEARSON, which is equivalent to CORREL.)

Example: Automatic Sorting of Data using LARGE

The LARGE function can be used to automate the sorting of a data set into ascending or
descending order. An advantage over the use of Data/Sort is that the sorted list is lived-
linked to the data set and so will update automatically if it changes (e.g. as new daily data
comes in).

The file Ch1.Stats.xlsx (SortLARGE worksheet) (Figure 1.21) shows an example in which
a data set is sorted by applying LARGE, where a set of integers from 1 upwards is used in
order to place the points in descending order. As covered in the next section, to find the date
on which any of these specific returns occurred, Lookup functions (such as the combination
of INDEX with MATCH or VLOOKUP if the data set were re-ordered appropriately) can
be used.

LOOKUP AND REFERENCE FUNCTIONS
Many Excel users have only a cursory awareness of Lookup and Reference functions.
However a good knowledge of them is arguably one of the single most important capabilities
required to construct intermediate and advanced models.
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Some frequently used examples are:

• MATCH finds the relative position of a specified value in an array.
• HLOOKUP (VLOOKUP) searches the top row (left column) of a table for a specified

value and finds the column in that row (row in that column) that contains that value. It
then provides the value that is at a specified row (column) within the table.

• INDEX looks up the value in a specified row and column of a matrix. The function also
exists in a reference form, where it returns a reference to specified cells rather than to
the value of a cell.

• OFFSET provides the value in a cell that is a specified number of rows and columns
from a specified reference cell or range. It can also be used to return the values in a range
of cells (rather than an individual cell) that is a specified number of rows and columns
from a certain reference cell or range.

• CHOOSE uses one of a set of values according to some key, and can be used where the
arguments are in a non-contiguous range. In some cases, the function can provide more
flexibility than the other Lookup functions.

• INDIRECT returns the reference specified by a text string.

There are other functions that may on occasion be useful, such as COLUMN (or ROW) to
find the column (row) number of the given reference, and COLUMNS or (ROWS) to find
the number of columns (rows) of a reference range.
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Figure 1.31

or sensitivities are required, as it will help to avoid confusion about which graph shows
which scenario. This is a two-step process. The first step involves creating the desired title
and labels as Excel formulae which update as the data changes (using the TEXT function).
The second step involves linking these formulae to the chart labels and title.

The file Ch1.Text.xlsx (GraphLabels worksheet) (Figure 1.34) shows an example. The
creation of the updating labels is achieved with the use of the TEXT function, such as:

=“USA (“&TEXT(C5,“0.0%”)&” p.a. growth)”

As a formula, the expression must of course begin with an equals (=) sign, with the first part
of the expression being made into a text label by enclosing it in inverted commas, which
is then joined to the rest of the formula using &. The TEXT function has a first argument
which refers to the cell containing the number to be updated, and a second argument which
defines the format to be used (another frequent format is to use “0.0” to show a numerical
field with one decimal point, or “0” to show no decimal places, as used for the chart
title). Some spaces may need to be added at appropriate places within the text fields, e.g.
immediately after an opening inverted comma or before a closing one.

The linking of the series names from a chart to the updating cells can be done when edit-
ing the data source of the chart. For chart titles, one must edit the title field typing = within
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the Excel Formula Bar, point to the cell containing the required title, and press
RETURN.

INFORMATION FUNCTIONS

Excel has a number of Information functions, many of which return TRUE (1 if used within
a formula) or FALSE (0 if used within a formula) according to whether some condition
holds. These can be used in many ways, including:

• Writing comments within numerical formulae. A formula can be multiplied by ISTEXT
with a comment as its argument (e.g. =105*ISTEXT(“data from 2007”) will evaluate to
105). ISNUMBER could also be used in this context, where the corresponding formula
is added rather than multiplied, as the presence of the text comment would result in this
formula evaluating to zero.

• General error checking (including in VBA code). ISERROR can be used to check for any
error value (#N/A, #VALUE!, #REF!, #DIV/0!, #NUM!, #NAME?, or #NULL!). The
function IFERROR (in Excel 2007) returns the value of an expression or an alternative
value when the base value returns an error. ISERR checks for any error value except
#N/A (value not available), and ISNA checks specifically for the #N/A error.

• Providing other information about the content, position or format of a cell, using functions
such as CELL and TYPE.
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number of a cell or its values) and a reference that specifies the cell for which information
is desired. It can be used in a variety of ways, such as:

• To provide an updating label for a variable (so that, for example, its description refers to
the data range that is being used in the formula for that variable).

• To show the cell in a workbook that was most recently changed, by using it in the form
CELL(“address”), i.e. without a reference argument.

The file Ch1.Info.xlxs (CELL worksheet) (Figure 1.36) shows an example.

ARRAY FUNCTIONS, FORMULAE AND MATRIX
CALCULATIONS

The use of array formulae is in some circumstances both powerful and unavoidable.
Examples include matrix multiplication and transposition, and formulae to count the fre-
quency of the occurrence of a set of points within a set of values.

Array formulae return arrays as their output, and must be entered in Excel using CTRL+
SHIFT+ENTER (rather than the usual ENTER). Some array functions extend over mul-
tiple cells, in which case the entire range must first be highlighted and the formula entered
in the Formula Bar or by selecting the function using the Formulas menu before entering
with CTRL+SHIFT+ENTER.
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the data to produce a histogram of the data set. In practice, the choice of the definition of
the width of the bins will be important; if the bin size is too wide the histogram will not
be sufficiently detailed, whereas for narrow bin widths the histogram will look fragmented
and multi-moded.

When using the FREQUENCY function, the entire range that is to contain the function
must be selected (this range must be one cell larger than the bin range because there could
be data points larger than the upper value of the largest bin), and the function must be typed
within the Formula Bar or by selecting the function using the Formulas menu (rather than
by direct typing in the first cell of the range, for example). On pressing CTRL+SHIFT+
ENTER the function will show the number of data points in the set that lie between the
lower bin value and the upper bin value. Once this function is entered the relative frequency
of each bin can be calculated.

The file Ch1.Array.xlsx (FREQ worksheet) (Figure 1.38) shows an example where the
average daily movement of the Dow Jones index for the period under consideration (2007) is
0.02% with a standard deviation of 0.92%. The bin size is set to 0.25%, starting at −3.00%.
As mentioned above, the range in which the function is entered is one cell larger than the
range containing the bins, to account for the data points that are larger than the maximum
bin value.
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As mentioned earlier, add-ins can be installed (and uninstalled) using the Manage tool
for add-ins under Office/Excel Options/Add-ins (or Tools/ Add-ins in Excel 2003). Once
loaded the add-ins may appear in several places in Excel (Solver and the Analysis Tool-
Pak appear under Data/Analysis, the Conditional Sum Wizard appears under Formu-
las/Solutions and so on. In Excel 2003, they appear under Tools).

The Analysis ToolPak

The Analysis ToolPak provides statistical tools to enhance the capabilities of Excel. In
Excel 2003, the add-in contains some functions that are directly included as worksheet
functions in Excel 2007 (and are accessible without the add-in being loaded). Some of the
most relevant for financial modelling include:

• XNPV calculates the net present value of non-equally spaced cash flows.
• XIRR calculates the internal rate-of-return of non-equally spaced cash flows.
• YEARFRAC calculates the fraction of the year corresponding to the number of days

between two dates.
• YIELD calculates the yield on a bond or security that pays constant periodic interest.

The add-in is relatively straightforward to use providing one is familiar with the underly-
ing statistical procedures. Most of these (e.g. analysis of variance, F-tests, t-tests, Fourier
analysis, and so on) are beyond the scope of this text. For the purposes here, the most
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directly relevant include the calculation of correlation coefficients (or covariances) and the
calculation of multiple regression coefficients and related statistics. An example of the use
of the Correlation option is provided below.

Example: Correlation Matrices Revisited

The Correlation tool within the Analysis ToolPak is especially useful to create correlation
matrices for large sets of data, and provides an alternative to the earlier methods shown
(which consisted of either manually setting up the formula for each element of the matrix
or using Lookup functions to create a general formula that can be copied to all matrix
elements.) One advantage of the use of the Data Analysis tool is to avoid the potential
complexities of using the Lookup functions. On the other hand a disadvantage of this
approach is that the correlation matrix is not live-linked and so needs to be updated if the
data changes.

The file Ch1.OtherTools.xlsx (DataAnalysisCorr worksheet) (Figure 1.46) shows an
example.

Example: Complex Conditional Sums using the Conditional Sum Wizard

The Conditional Sum Wizard can in some circumstances provide a more appropriate
alternative to the use of Database functions, PivotTables, or the SUMIF function. (As
mentioned earlier Excel 2007 also has a SUMIFS function in which a range is summed
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according to multiple criteria being met, and this can also be used in this context; an example
is also shown.)

The wizard can be used to generate formulae with multiple embedded conditions in an
automated way. The formula generated is an array function, therefore if it is edited or
modified it will need to be entered using CTRL+SHIFT+ENTER (see earlier).

The step-by-step wizard is essentially self-explanatory. When on step three, the option
copy the formula and conditional values can be chosen to ensure that the formula gen-
erated during step four refers to the value of particular conditions (which will be placed
in separate individual cells); in this way, the formula is easier to adapt, copy and modify
so that different conditional values can be tested, i.e. that multiple database queries can be
set up. Note that if a different query is required (such as requiring three conditions to be
satisfied instead of two), then it is generally easier to re-run the wizard than to try to adapt
the formula directly. However, where the number of conditions to be satisfied is unchanged,
then often a direct adaptation of the formula is easy to achieve (e.g. adapting a base formula
which tests for two conditions so that two different conditions are satisfied).

The file Ch1.OtherTools.xlsx (CondSum worksheet) (Figure 1.47) shows an example
of the result of applying the wizard in this way. The results are compared with the use of
the DSUM formula shown earlier and with the use of the SUMIFS function. Note that the
formula can be copied to different cells so that different criteria can be created, whereas
the use of the DSUM function would require a new criteria range for each application of
the function.




